Sonance
Navigator K2
Touchscreen Keypad

Sonance
The Leader in Architectural Audio™
FEDERAL COMMUNICATIONS COMMISSION NOTICE

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference and (2) this device must accept any interference received, including interference that may cause undesired operation.

© 2002 All rights reserved.
Sonance is a registered trademark of Dana Innovations,
IMPORTANT SAFETY INSTRUCTIONS

Read Instructions - All the safety and operating instructions should be read before the appliance is operated.

Retain Instructions - The safety and operating instructions should be retained for future reference.

Heed Warnings - All warnings on the unit and in the operating instructions should be adhered to.

Follow Instructions - All operating and use instructions should be followed.

Heat - The unit should be situated away from heat sources such as radiators, heat registers, stoves, or other appliances (including amplifiers) that produce heat.

Power Sources - The unit should be connected to a power supply only of the type described in the operating instructions or as marked on the appliance.

Water and Moisture - The unit should not be used near water - for example, near a bathtub, washbowl, kitchen sink, laundry tub, in a wet basement, or near a swimming pool, and the like.

Object and Liquid Entry - Care should be taken so that objects do not fall and liquids are not spilled into the enclosure through openings.

Cleaning - The unit should be cleaned only as recommended by the manufacturer.

Servicing - Do not attempt any service beyond that described in the operating instructions. Refer all other service needs to qualified service personnel.

Damage Requiring Service - The unit should be serviced by qualified service personnel when:

- Objects have fallen or liquid has been spilled into the unit.
- The unit has been exposed to rain.
- The unit does not appear to operate normally or exhibits a marked change in performance.
- The unit has been dropped or the enclosure damaged.

WARNING!

TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE THE UNIT TO RAIN OR MOISTURE. NO USER SERVICEABLE PARTS INSIDE.
LIMITED WARRANTY AND DISCLAIMER

If, within five (5) years from the date shown on the bill of sales, the unit fails due to a defect in workmanship or materials, Sonance will, at its option and at no charge to the purchaser, repair or replace the components of such unit which proves to be defective.

For this warranty to be effective, the bill of sale must show that the unit was purchased from an authorized Sonance retailer. This warranty shall apply exclusively to the original purchaser and shall not apply to units purchased for industrial or commercial use.

Furthermore, this warranty shall not apply if:

1. Damage to the unit was caused by accident, abuse, or misuse;
2. The unit was modified, or repaired by unauthorized personnel; or
3. The unit was not used as outlined in the operating instructions

Exclusions and Limitations

The warranty set forth above is in lieu of all other warranties; express or implied, of merchantability, fitness for a particular purpose, or otherwise. The warranty is limited to Sonance products registered herein and specifically excludes any damage to any associated equipment, which may result for any reason from use with this product.

Sonance shall, in no event, be liable to incidental or consequential damages arising from any breach of this warranty or otherwise. This warranty gives you specific legal rights, and you may have other rights, which vary from state to state.

If your Navigator K2 keypad needs service, please contact Sonance by telephone, fax, or E-mail for return information (See Chapter 9). Please do not return products to Sonance without return authorization.

All rights are reserved. No part of this document may be photocopied, reproduced, or translated without the prior written notice of Sonance.

The information contained in this document is subject to change without notice. Sonance shall not be liable for errors contained herein or for consequential damages in connection with the furnishing, performance, or use of this material.

Microsoft and Windows are registered trademarks of Microsoft Corporation. Other brands and their products are trademarks or registered trademarks of their respective holders.

Sonance Navigator and the Sonance logo are registered trademarks of Sonance.
Table of Contents

Federal Communications Commission Notice ........................................................................ III
IMPORTANT Safety INSTRUCTIONS ......................................................................... IV
Limited Warranty and Disclaimer ................................................................................. V

Table of Contents VI

Chapter 1. Welcome  1

Note................................................................................................................................. 1
Unpacking and Inspection ............................................................................................. 1
Product Contents .......................................................................................................... 2
Software Requirements................................................................................................. 2

Chapter 2. Introduction  3

Features ......................................................................................................................... 3
Important Notes ........................................................................................................... 4
Cleaning .......................................................................................................................... 5
Keypad Reference ......................................................................................................... 5
The Touchscreen Display ............................................................................................. 6
The Control Panel Page ................................................................................................. 6

Chapter 3. Navigator K2 Manager™ Software  11

Installing Navigator K2 Manager .................................................................................. 11
Programming Overview ............................................................................................... 11
Navigator K2 Manager Screen ...................................................................................... 12
Touchscreen Grid .......................................................................................................... 13
Design Hints .................................................................................................................. 13
Getting Help ................................................................................................................. 14

Chapter 4. Navigator K2 Manager Basics  15

How to Add a Page ........................................................................................................ 15
How to Delete a Page .................................................................................................... 15
How to Add Buttons ...................................................................................................... 16
How to Delete Buttons .................................................................................................. 16
How to Add Text to Buttons ......................................................................................... 17
How to Place a Bitmap .................................................................................................. 18
How to Add Commands to Buttons ............................................................................. 20
How to Delete Commands from Buttons ..................................................................... 22
How to Link Pages ......................................................................................................... 22
How to Remove Page Links ......................................................................................... 23
How to Save a File ......................................................................................................... 23
How to Open an Existing File ....................................................................................... 23
How to Preview your File .............................................................................................. 24
How to Setup Communications .................................................................................... 25
How to Send a File to the Navigator K2 ....................................................................... 26

Chapter 5. Navigator K2 Manager Advanced Features  28

How to Rename a Page .................................................................................................. 28
How to Duplicate a Page ............................................................................................... 28
How to insert a frame ..................................................................................................... 28
How to delete a frame .................................................................................................... 28
How to Merge Pages ...................................................................................................... 29
How to Use the PageWizard ......................................................................................... 30
How to Change Button Styles....................................................................................... 30
How to Select Buttons ................................................................. 31
How to Cut or Copy Buttons ............................................................ 31
How to Paste Buttons .................................................................. 31
How to Move a Button .................................................................. 32
How to Resize a Button ................................................................ 32
How to Place a Custom Button ...................................................... 32
How to Use the Macro Editor ......................................................... 34
How to Delete a Macro .................................................................. 40
How to Edit an IR Command in a Macro ....................................... 40
How to Use the Channel Macro Wizard ....................................... 41
How to Create a New Scrolling List .............................................. 43
How to Edit a Scrolling List ........................................................... 45
How to Edit the Device properties ............................................... 46
How to Edit Button Properties ....................................................... 54
How to Edit the Properties of Multiple Buttons ......................... 57
How to Use the “IR Code Search & Replace” Feature .................... 58
How to Print System Configuration Reports ................................ 58
How to Check Memory Usage ....................................................... 59
How to Create a “Self-Downloading .EXE” ................................... 59
How to Use the “Send” Command ................................................ 60
How to Update the Firmware ........................................................ 60

Chapter 6. Image Editors ............................................................. 62
The Difference Between Custom Buttons and Bitmaps ................... 62
Button Bitmap Editor Screen ....................................................... 63
Custom Button Editor Screen ...................................................... 64
Toolbar ......................................................................................... 65
Tool Palette .................................................................................. 67
Up Image-Down Image Tool (Custom Button Editor Only): ............ 69
New Bitmap Size Dialog Box (Button Bitmap Editor Only): .......... 70

Chapter 7. IR Library Manager ....................................................... 72
Master and User Command Libraries ......................................... 72
IR Library Manager Screen .......................................................... 72
Toolbar ......................................................................................... 73
Remote Function Window ............................................................. 74
Creating, Editing and Assigning IR Codes to Remote Files ............ 76

Chapter 8. Troubleshooting .......................................................... 79
Communication Problems ............................................................ 79
Macro Problems ......................................................................... 80
IR Problems ............................................................................... 81

Chapter 9. Service and Support ..................................................... 83
Updates and New Products ........................................................... 83
Contacting Sonance .................................................................... 83
Sonance Technical Support .......................................................... 83
Shipment of Navigator K2 KEYPAD for Service ............................ 85

Specifications ............................................................................. 87
Appendix ....................................................................................... 90
Index ......................................................................................... 96
Navigator K2 keypad
Chapter 1. Welcome

Congratulations on your purchase of the Sonance Navigator® K2 touchscreen keypad. The Navigator K2 combines the power and flexibility of a graphic LCD touchscreen with the convenience and familiarity of real buttons.

Navigator K2 takes complete control of the home’s audio/video, lighting, and other systems, replacing all other user interfaces. It features an intuitive, easy to read LCD that can display custom buttons, text, graphics, and symbols. In addition to the backlit display, 11 “hard” keypad buttons allow easy access to frequently used functions.

Programming is easy and convenient thanks to the advanced Windows® based software.

NOTE

The Navigator K2 and Navigator K2 Manager software are compatible with infrared (IR) commands with carrier frequencies between 15kHz and 460kHz, as well as those commands that do not use a carrier (the built-in infrared receiver is only compatible with carrier frequencies between 20kHz and 120kHz). This covers the vast majority of remote controls available to date.

Despite every effort to make the Navigator K2 universal system controller work with all IR systems, some IR-controlled products are unable to be controlled by the Navigator K2 due to incompatible frequencies or non-standard IR formats. The Navigator K2 cannot reproduce non-IR formats such as RF and ultrasonic.

UNPACKING AND INSPECTION

After unpacking your new Navigator K2 keypad, save all of the packing materials, in case you ever have to ship the unit.

Thoroughly inspect the Navigator K2 and packing materials for signs of damage. Report any damage to the carrier immediately. Report any equipment malfunctions to Sonance.
PRODUCT CONTENTS

Contents within the box include the following items:

- Sonance Navigator K2 keypad
- White colored wall plate
- Serial cable for programming
- Getting started card
- Wall cut-out template
- Two spare self retention tabs

SOFTWARE REQUIREMENTS

*Sonance Navigator K2 Manager* software minimum system requirements:

- Windows® 98, Windows ME, Windows 2000, Windows XP, or higher operating system
- IBM or compatible PC with 486DX2/66Mhz or higher processor
- 16 Megabytes (MB) of RAM
- 8 Megabytes of free disk space for minimum installation (16 MB recommended)
- A mouse or other pointing device is required
- S-VGA monitor (256 colors minimum)
- Open RS-232 serial port
- Optional printer for printing setup reports
Chapter 2. Introduction

The Navigator K2 is a programmable touchscreen keypad that is designed to provide wired control of audio/video and other electronic systems. The Navigator K2 is a stand-alone controller that can be thought of as a universal remote control that is permanently installed on a wall. Like other “universal” or “learning” remote controls, the Navigator K2 allows you to consolidate the functions of many independent infrared remote controls into one unit. The Navigator K2 also incorporates a unique programmable user interface, allowing it to provide a simple, intuitive, and customized interface for any system. Before using the Navigator K2, please read and follow all instructions in this manual.

FEATURES

The Navigator K2 provides superior quality and reliability as well as these specific features:

- A replacement for all of your system’s remote controls. The Navigator K2 can reproduce all of the commands of almost any infrared remote control.

- A programmable graphic display. The Navigator K2 uses powerful Windows® based software that makes it easy to place buttons, text, graphics, and symbols anywhere on the display.

- A backlit LCD with digital matrix touchscreen. When you want to perform a command, simply touch the display where that command is displayed. The touchscreen never needs calibrating.

- Real buttons. The Navigator K2 has 11 backlit “hard” keypad buttons that allow easy access to frequently used functions. The six source buttons can be re-labeled using a separate membrane keypad kit (Sonance part number 91949)

- A macro function. This feature allows the Navigator K2 to perform a series of commands by pressing a single button. For example, you can create a macro called “Movie” that turns on the TV, sets the correct channel, turns on the VCR, dims the lights, and starts playing a movie.

- Automatic power on and off. The Navigator K2 powers itself down whenever it is not used for a pre-set amount of time. Touching any area of the display or a hard button will turn it on again.

- Industry standard IR output port. The Navigator K2 can be wired into standard IR repeater systems.

- Power status feedback. The Navigator K2 can be connected to the power status trigger output or a switched outlet (via a plug-in power adapter) of audio controllers or receivers to indicate system power status using the bi-
color LED's behind the keypad’s “OFF” button. The color of these LED’s can also be changed manually by issuing a command within a macro.

- Relay Control output. The Navigator K2 can be connected to a speaker relay module (Sonance part number 91550) for muting individual rooms or zones. This can also be used to control other relay controlled products.

- Keypad sync bus. Individual K2 keypads can be tied together so that the display, power status, and mute status changes on all keypads when a change occurs on any one of them. In other words, each of the K2 keypads that are tied together will track the changes made to any of the other keypads.

- A serial port for communication with the Navigator K2 Manager programming software.

- Non-volatile flash memory. The Navigator K2 will not lose any programmed data when the power is removed.

- Easy installation. The K2 fits inside many standard double-gang electrical boxes for installation in new construction. It also has a self-contained mounting system for retrofit applications.

- Five-year parts and labor warranty.

**IMPORTANT NOTES**

Please read these important notes about the Navigator K2:

- The Navigator K2 should be placed in an area where it is around normal room temperature (between 60°F to 90°F). If the temperature is too hot, the display appears dim. If the temperature is too cold, the display appears dark and may respond slowly.

- Do not use sharp objects on the touchscreen. It is designed to operate with a touch of your finger.

- Do not let the Navigator K2 get wet. It should not be handled with wet hands or be placed in an area where it could get wet.

- Do not subject the Navigator K2 to smoke, dust, or vibrations. The display may be damaged from excessive shock or vibration.

- Use only a power supply that is provided by Sonance. Using the wrong type of power supply may result in product failure or other damage.
• Do not disassemble the unit. The Navigator K2 contains high voltage circuits that may cause injury if contacted.

CLEANING

Occasional cleaning may be required, depending on use.

To clean your Navigator K2:
1. Remove the power from the Navigator K2.
2. Lightly dampen a lint-free cloth with water or mild detergent and wipe the touchscreen, keypad, and outer surfaces.

KEYPAD REFERENCE
THE TOUCHSCREEN DISPLAY

The Navigator K2 touchscreen display is organized as a series of pages and frames. A page can consist of up to 12 frames of information having one frame displayed on the screen at a time.

Normally each frame on a page contains objects (buttons, text, graphics, and symbols) that are related in some way. For instance, they may all display information necessary for controlling a particular DVD player.

By default, the Navigator K2 has one Main Menu page. This is the first page that is displayed when power is applied to the K2. It is programmed at the factory to display a sample page with a graphic of the Sonance logo on it.

A page is normally created for each device or system to be controlled. Each of these pages is then attached to one of the “hard” source buttons on the K2. Also, any page can contain a button(s) that will display any other page when selected. The K2 will support 63 pages plus the Main Menu page.

THE CONTROL PANEL PAGE

The Control Panel page can be displayed by pressing and holding both frame arrows for at least 5 seconds.

You can also access the Control Panel page by assigning a “Control Panel” page link to a button using the Navigator K2 Manager software.

The Control Panel consists of the following two frames:

To change frames, press the frame Left or frame Right buttons on the bottom of the touchscreen. To return to your Navigator K2 program, press the OFF button.
IR RECEIVER

This button displays a window that allows you to enable or disable the infrared receiver. The infrared receiver is used to relay commands from a wireless infrared remote control near the K2 back to the device being controlled. **The default setting for this feature is off.** It is recommended that this feature be turned off if not needed. Electronic and light noise in the room where the K2 is installed can interfere with the IR commands. The **Signal** bar at the top of the window shows you what the IR receiver is detecting – it turns dark in response to infrared energy that is present. Press the **OK** button in the window to close.

BEEPER

This button displays a window that allows you to turn the audible beep on or off. The beeper provides feedback that a button was pressed. Press the **OK** button in the window to close.

TIME OUT

This button displays a window that allows you to adjust the amount of time the unit waits before power down after the last button press. The time is variable from 1 second to 60 seconds (default is 10 seconds). Press the arrows to the left or right of the **Time Out** setting to adjust the time. Press the **OK** button in the window to close. The backlight level during power down can be adjusted from a medium backlight level to completely off to minimize power consumption on the system.
BACKLIGHT LEVEL

This button displays a window that allows you to set the backlight brightness level of the K2. There are independent settings for the K2’s **Normal** operating mode (when it is awake) and the **Power Down** mode (when it is asleep). The four brightness choices are High, Medium, Low, and Off. For the Power Down mode you can also select the **Display Off** option if you want the display to show no information while the K2 is asleep. The High brightness setting is not allowed in the Power Down mode. Press the **OK** button in the window to close.

CHANGE PASSCODE

This button displays a window that allows you to set the passcode that is used to limit access to the **Clear All** function on the control panel page as well as the **Secured** function that is available on all buttons.

When you press the **Change Passcode** button, the screen will prompt you to enter the **old** passcode on the touchscreen followed by the **Enter** key.

(The default code is **0000**).
Now enter a **new** four-digit passcode, then press **Enter**.

You will be prompted to enter the **new** four-digit passcode again for confirmation, then press **Enter**.

When new code is entered successfully, the **Code Changed** window will pop up to let you know you have changed the passcode.

**Do not forget the passcode!**
CLEAR ALL

This button displays a window that will allow you to erase the current program in the Navigator K2 keypad. When the button is pressed, you will be prompted to enter the current passcode. If the proper code is entered, the entire program in the Navigator K2 will be erased.

Warning! This will erase the complete program in the Navigator K2 with no way to restore it, except by reloading the program from the Navigator K2 Manager software!

If you inadvertently press the CLEAR ALL button, simply press the ENTER button without entering the passcode and you will be returned to the Control Panel page.

Note! All control panel settings are available through the “Edit Device Properties” window in the edit pull down menu (see chapter 5). Control panel settings are also reset with every file load so be sure the device properties are set correctly in each of your files.
Chapter 3. Navigator K2 Manager™ Software

*Navigator K2 Manager* allows you to create the entire graphical interface for a Sonance *Navigator K2* keypad on your computer. Once the interface has been created, it is downloaded to the *Navigator K2* using the included programming cable. Existing programming can also be extracted, modified, and re-sent to any *Navigator K2* keypad.

Software updates are available for download at no cost at [www.sonance.com](http://www.sonance.com).

**INSTALLING NAVIGATOR K2 MANAGER**

For installation from the internet:

1. Using your Web browser, go to the following URL: [www.sonance.com](http://www.sonance.com)
2. When the Web page opens, locate the K2 page under Electronics. Follow the directions to download the *Navigator K2 Manager*.
3. Follow the on-screen instructions.

For installation from a CD-ROM:

1. Close any open programs.
2. Place the *Navigator K2 Manager* compact disc into the CD-ROM drive.
3. If the installation doesn’t appear automatically, click Start and choose Run, type d:\setup\setup.exe (For d, type the letter for your CD-ROM drive). Click OK.
4. Follow the on-screen instructions.

**PROGRAMMING OVERVIEW**

Here is an overview of the process of programming a *Navigator K2* from scratch. Instructions on carrying out these tasks can be found in chapters 4 and 5.

1. Create a new page and add buttons for each source component in a system.
2. Use the Assign Page tool to link source buttons to their respective source component pages.
3. Assign infrared codes and other commands to buttons using the Infrared Library.
4. Create macros using the Macro Editor (if needed).
5. Check the Device Properties.
6. Save the file.
7. Send the file to the Navigator K2 using the communications commands.
TOUCHSCREEN GRID

The touchscreen grid is where the buttons, text, graphics, and symbols are placed. Click on the frame Left or frame Right buttons at the bottom of the touchscreen grid to place buttons on other frames.

DESIGN HINTS

1. Be consistent with the location of similar buttons. For example, if you have a DVD player and a VCR in your system, try to make the transport controls (Play, Pause, Stop, etc.) on both pages look similar.

2. It’s not necessary to re-create each donor remote in its entirety on the Navigator K2. Think of the functions the user will be using daily.

3. Use macros to hide complex command sequences from the user. For example, instead of presenting the user with only the numeric keypad for changing channels on their TV, make a set of macros for CBS, HBO, etc. that send the proper channel numbers automatically. The Channel Macro Wizard makes it easy to create this type of macro.
Navigator K2 keypad

GETTING HELP

*Navigator K2 Manager* includes an extensive on-line help system. If you need help with any tool or command, click the **What’s this?** button on the **Toolbar**.

If you need an explanation of any item in a dialog box, click the **Help** button in the dialog’s title bar and then click on the control you would like to learn about.
Chapter 4. Navigator K2 Manager Basics

The Navigator K2 keypad is divided into two sections: the touchscreen and the “hard” buttons. You can assign commands, macros, and page links to any button you create on the touchscreen or on the “hard” buttons.

The “hard” button functions of the Navigator K2 follows the pages, not the frames, so all 12 frames of a page will have the same commands, macros, and page links on the “hard” buttons. Each frame of the touchscreen can have buttons with different commands, macros, and page links.

All of the “hard” buttons on the K2 can be programmed as Global buttons. When a button is set to Global, its functions are common across all of the pages (i.e. it does the same thing on every page).

PAGES

The individual screens on the Navigator K2 keypad are called pages. Pages on the touchscreen can contain buttons, links to other pages, a title, text, commands, and macros.

The page links, commands, and macros associated with the “hard” buttons on the Navigator K2 are also stored with each page.

Each page can have up to 12 frames on the touchscreen and usually has the controls for just one component. Each frame is accessed by scrolling left and right with the arrows at the bottom of the Navigator K2 touchscreen. With Navigator K2 Manager, you can add and delete pages, duplicate pages, etc.

All Navigator K2 pages have a page title. The page title is the name that appears in the title bar above the touchscreen grid and in the Page List.

HOW TO ADD A PAGE

1. Click the Create New Page command on the Toolbar.
2. Enter a name for the page in the New Page Title dialog. This is usually the name of the component, such as: CD, Satellite, Lights, and so on.
3. Click OK.
   Repeat this procedure for each page you wish to add.

HOW TO DELETE A PAGE

1. Select the page to be deleted from the Page List.
Navigator K2 keypad

2. Click the **Delete Current Page** command on the **Toolbar**.

3. Click **Yes** in the **Delete Page** confirmation box.

**BUTTONS**

Buttons are the functional elements of the Navigator K2 keypad. Each button can be associated with commands, macros, and page links. Creating buttons in the touchscreen grid consists of making the button itself and then adding text, bitmaps, or symbols to them.

**HOW TO ADD BUTTONS**

1. Select a page from the **Page List** and then the frame on that page with the frame left and right arrows on the bottom of the touchscreen grid.

2. Select the **Draw Button** tool from the **Tool Palette**.

3. Select the style of button from the **Button Style Palette**.

4. Place the mouse cursor over the cell in the touchscreen grid where one corner of the button will be.

5. Click and hold the left mouse button and drag the mouse to the opposite corner of where the button will be.

6. Release the left mouse button when the button has the desired shape and size.

   Repeat this procedure for each button you wish to add.

**HOW TO DELETE BUTTONS**

1. Select the **Delete** tool from the **Tool Palette**.

2. Place the mouse cursor over the button to delete.

3. Click the left mouse button.

4. Select **Delete Button** from the menu.
HOW TO ADD TEXT TO BUTTONS

1. Select the Edit Text tool \[A\] from the Tool Palette.
2. Place the mouse cursor over the button you want to add or edit text on.
3. Click the left mouse button. Please note that the taller the button the more lines you will have available for text.

4. Enter the text in the Edit Button Text dialog and click OK.

You can use any of the options in the Edit Button Text dialog to customize the button.

- [B] Make the text bold.
- [ ] Justify the text to left side of the button.
- [ ] Center the text horizontally in the button.
- [ ] Justify the text to the right side of the button.
- [ ] Shift the text to the top of the button.
- [ ] Center the text vertically in the button.
- [ ] Shift the text to the bottom of the button.
- [ ] Enable the auto-complete feature, which will automatically finish typing the name for commonly used buttons.
Click on any of the symbols at the bottom the dialog box to insert them into the active line.

HOW TO PLACE A BITMAP

The **Bitmap Tab** in the **Library Browser** allows you to attach bitmaps to buttons in your file or to create new bitmap buttons by dragging the bitmaps from the **Bitmap Library** to the touchscreen grid. Hold the mouse over any bitmap in the **Bitmap Library** window to see its title and the **Bitmap Library** it is stored in.

If you drop the bitmap onto an empty section of the touchscreen grid, a new button is automatically created with the default style, and the bitmap is placed on that button.

If you drop the bitmap onto an existing button, any text or bitmap already on that button is replaced with the bitmap that you drop.

1. Select the **Bitmap Tab** on the bottom of the **Library Browser**.
2. Drag any bitmap from the **Bitmap List** onto the touchscreen grid.
HOW TO ADD COMMANDS TO BUTTONS

IR commands are indicated by a small red box with the letter ‘C’ in the upper right corner of buttons they have been assigned to.

1. Select the **Infrared Tab** from the **Library Browser**.
2. Click the **Select New Remote** button in the **Infrared Library** window to select a different remote than displayed.

Remotes are listed by manufacturer, type, and model in the **Select Remote from Library** window; use this to select the remote you would like to assign codes from.

Remotes that have already been used in the current remote file will be moved to the top of the list and their icon will turn red for easy identification.
3. If the remote is in a different library or no library is open, click on the **Open Library** button to find the library file you are looking for.

   Default directory is: [C:\Program Files\Navigator K2 Manager\Command Libraries]

4. Click on the remote you would like to assign codes from and those codes will now appear in the **Library Browser**.

5. Place the mouse cursor over the function in the list that you want to attach to a button.

6. Click and hold the left mouse button.

7. Drag the mouse cursor to the button on which you want to place the command.

8. Release the left mouse button.

If you drag a command to a spot on the touchscreen grid where there are no buttons, *Navigator K2 Manager* will automatically create a button and insert the text for that command.
HOW TO DELETE COMMANDS FROM BUTTONS

1. Select the **Delete** tool from the **Tool Palette**.
2. Place the mouse cursor over the button with the command you wish to delete.
3. Click the left mouse button.
4. Select **Delete IR Code** from the menu.

HOW TO LINK PAGES

The **Navigator K2 Manager** software gives you the ability to link pages. When a button with a page link is pushed on the **Navigator K2**, the linked page becomes active, in essence turning the page.

Page links are indicated by a small green box containing the number of the linked-to page in the lower left corner of the button.

1. Select the **Assign Pages** tool from the **Tool Palette**.
2. Place the mouse cursor over the button to which you wish to assign a page.
3. Click the left mouse button.
4. Select the page name you wish to link to from the pop-up menu.
5. Notice the number in the green square in the lower left corner of the button corresponds to the linked page in the list.
Two additional options are available for linking:

- `<previous>` will take you back to the last page that was displayed.
- `<control panel>` will switch to the built-in Control Panel page.

**HOW TO REMOVE PAGE LINKS**

1. Select the **Assign Pages** tool from the **Tool Palette**.
2. Place the mouse cursor over the button from which you wish to remove the page link.
3. Click the left mouse button.
4. Select the `<none>` item from the bottom of the pop-up menu.

**HOW TO SAVE A FILE**

The files created with Navigator K2 Manager hold all the elements that make up an individual remote file. They have the extension `.sna` and may be stored in any directory.

Default directory is: `[C:\Program Files\Navigator K2 Manager\My Keypads]`

1. Click the **Save File Command** on the **Toolbar**.
2. Specify the name and directory for the file when saving for the first time and click **Save**.

**HOW TO OPEN AN EXISTING FILE**

1. Click the **Open File Command** from the **Toolbar**.
2. Click on the file you wish to open.
3. Click **Open**.
HOW TO PREVIEW YOUR FILE

The Preview mode in Navigator K2 Manager allows you to see exactly what your file will look like when it is sent to the Navigator K2 keypad.

Click the Preview Mode Command from the Toolbar.

Use the mouse to press the buttons in the preview window. The buttons will push-in just like they would on the Navigator K2, and if they are linked to another page, the linked page will become the current page in the Preview Window.

Click the Preview Mode Command from the Toolbar again when you are finished testing your file.

(Please note that the control panel can not be previewed in this mode. It is available only on the Navigator K2 keypad itself.)
HOW TO SETUP COMMUNICATIONS

The Communications Setup dialog box is for setting up communications between the Navigator K2 and your PC.

To open the Communications Setup dialog box:

Choose Set COM Port from the Options menu.

Com Port group box - Choose the COM Port that the Navigator K2 is connected to.

Auto Detect - Click this button to have Navigator K2 Manager attempt to automatically locate the correct COM port. The Navigator K2 must be connected to the computer using the programming cable.

Maximum Com Speed - Choose a lower speed from this list if you are having problems communicating with the Navigator K2 keypad. The default is High.
HOW TO SEND A FILE TO THE NAVIGATOR K2

1. Connect the Programming Cable from the Navigator K2 serial port to the desired COM port on your computer. This should be the COM port you set up using the Communications Setup dialog.

2. Click the Communications Command on the Toolbar.

3. Choose Send File.

All buttons, commands, bitmaps, and macros are sent. Any existing program in the Navigator K2 is replaced with the file you send.

All communications take place on the COM port selected with the Set COM Port command from the Options menu.
Chapter 5. Navigator K2 Manager Advanced Features

HOW TO RENAME A PAGE

1. Make sure the desired page is displayed in the touchscreen grid.
2. Select the **Edit Text** tool \[A\] from the **Tool Palette**.
3. Place the cursor over the page title area at the top of the touchscreen grid and click the left mouse button.
4. Specify the new page title and click **OK**.

HOW TO DUPLICATE A PAGE

Pages can be instantly duplicated. This is useful when pages share common buttons like channel macros or transport controls. One page can be created with these buttons and duplicated as many times as needed.

1. Make sure the desired page to be duplicated is displayed in the touchscreen grid.
2. Click the **Duplicate Page Command** \[B\] on the **Toolbar**.
3. Give the new page a different name and click **OK**.
4. The new page appears at the end of the page list.

HOW TO INSERT A FRAME

A blank frame can be inserted in front of an existing frame in a page.

1. Make sure the desired frame position is displayed in the touchscreen grid.
2. Select the **Insert Frame** command from the **Page** menu.
3. A blank frame will be inserted at the current frame position, and all existing frames will be shifted one frame to the right.

HOW TO DELETE A FRAME
1. Make sure the desired frame is displayed in the touchscreen grid.
2. Select the **Delete Frame** command from the **Page** menu.
3. The current frame will be deleted, and all frames to the right will be shifted one frame to the left.

**HOW TO MERGE PAGES**

The Merge Pages dialog makes it possible to move groups of pages from another .sna file to the current file.

1. Click the **Merge Pages** tool on the **Toolbar**.
2. Select the remote file from which you wish to merge pages from. Choose from the list located in the **Select file to merge from** dialog box and click **Open**.

3. Place a check next to each page you would like to merge into the current file.
4. You can click the frame left and frame right arrows to see the individual frames on a page.
5. When finished selecting pages, click **OK**.

All of the marked pages in the list are placed at the end of the current file.
HOW TO USE THE PAGEWIZARD

Navigator K2 Manager comes with a library of pre-built pages for many common types of equipment that you can insert into your file and customize as desired. The page library is accessed through the Page Wizard tool.

To add a pre-built page to your file:

1. Click the Page Wizard Command on the Toolbar.

2. Scroll through the list of available pages and select the one you want. You can use the Next Page and Prev Page buttons to see previews of all the pages if there is more than one.

3. Click the Insert button to add the page(s) to your file.

4. Click the Close button to close the dialog box.

The new page(s) appear at the end of the page list.

Use the editing tools to customize the button style to fit the rest of your file and to place commands, page links, and macros on the buttons.

HOW TO CHANGE BUTTON STYLES

1. Select the Draw Button Tool from the Tool Palette.
2. Select the style of button from the Button Style Palette.
3. Place the mouse cursor over the button you wish to change.
4. Click the left mouse button.
HOW TO SELECT BUTTONS

The Select Button tool is used to select buttons for cutting, copying, moving, resizing, or property editing. When buttons are selected, they are painted in red.

To select a single button or a group of buttons next to each other:

1. Click the Select Button tool on the Tool Palette.
2. Place the mouse over one corner of the button(s) and click the left mouse button.
3. Draw a rectangle around the buttons you wish to select in the design window (either in the touchscreen grid or the keypad buttons).

To select multiple buttons at one time that are not next to each other:

1. Click the Select Button tool on the Tool Palette.
2. Hold down the Ctrl key on your keyboard.
3. Click the buttons you wish to select (either in the touchscreen grid or the keypad buttons).

Note: Many Navigator K2 Manager commands can be used on selections as well as individual buttons. Click the right mouse button on a selection for a list of available commands.

HOW TO CUT OR COPY BUTTONS

1. Use the Select Button tool from the Tool Palette to select the button(s).
2. Choose either the Cut Command or the Copy Command from the toolbar.
3. The button(s) are now on the clipboard.

HOW TO PASTE BUTTONS

1. Select the page you want to paste the button(s) on from the page list.
2. Choose the Paste Command from the Toolbar.
3. Drag the button(s) to the proper place on the page.
HOW TO MOVE A BUTTON

1. Use the Select Button tool from the Tool Palette, to select the button(s).
2. Hold down the left mouse button to drag the selection to a new location.
3. Release the left mouse button to place the button(s).

HOW TO RESIZE A BUTTON

Existing buttons on the touchscreen grid may be re-sized using Navigator K2 Manager. The text on a button may be clipped if the size is reduced, but any associated command or macro will not be lost.

1. Use the Select Button tool from the Tool Palette to select the button. Note that to resize a button, only one button can be selected. If the selection can be resized, small boxes will appear in the red border on all four sides.
2. Position the mouse over the edge of the button that you would like to resize.
3. Click the left mouse button.
4. Drag the mouse to change the size.
5. Release the mouse button when you have the desired size.

HOW TO PLACE A CUSTOM BUTTON

The Custom Button Library Browser allows you to select and place Custom Buttons onto the touchscreen grid.

1. Select the Place Custom Button tool from the Tool Palette.
2. Select the library in which the custom button you want is located by clicking the Open Library button, selecting the library and clicking Open.
   
   Default directory is: [C:\Program Files\Navigator K2 Manager\Custom Buttons]
3. Click on a button name and a preview of the button will appear in the Custom Button Library Browser.
4. Click OK to insert the custom button on the touchscreen grid and close the Custom Button Library Browser.
5. Drag the custom button to the proper place on the page.
HOW TO USE THE MACRO EDITOR

Macros are a sequence of commands placed on any single button. Macros are placed by using the Edit Macro command found on the Tool Palette.

Buttons with macros can be moved, cut, copied, and pasted to other pages without discarding the codes attached to them.

Macros are indicated by a small black box with the letter ‘M’ in the upper left corner of buttons.

EDITING MACROS

To add a new macro or edit an existing macro on a button:

1. Select the Edit Macro tool from the Tool Palette.
2. Click the button to which you would like to add a new macro or edit an existing macro.
3. Use the tools in the Macro Editor window to add, insert, and delete commands.
4. Click OK in the Macro Editor window to save changes to the macro, or click Cancel to discard them.
Report command – The Report command button at the bottom of the macro editor opens up your default web browser for viewing and printing of the open macro.

Trash Can – The Trash Can located at the bottom of the macro editor is used to delete commands from a macro. Left click and hold the command you want to delete and drag it to the Trash Can and release.

The Infrared from Library macro step type causes the macro to output an Infrared command. Any number of Infrared commands can be added to the macro by selecting the proper library and then dragging the desired function(s) from the list on the right side to the macro display on the left side of the Macro Editor.

If you do not have access to the Infrared Library with the desired function, but it is assigned to a button in the current file, use the Infrared from Page step type to add it to the macro.

Double-click the infrared command step in the macro if you need to edit any of the parameters.

The Infrared from Page macro step type causes the macro to output an Infrared command. The command is taken from a button in the current file. Select the page containing the desired code and then drag the code from the Available Buttons list on the right to the macro display on the left.

This should be used for maintaining files for which the Infrared Library is not available. If the desired command is in an Infrared Library, use the Infrared from Library step type.

Double-click the infrared command step in the macro if you need to edit any of the parameters.

The Time Delay step causes the macro to pause for the time specified by the Delay Time spin box. The time can be adjusted from 0.1 to 9.9 seconds. After you have set your desired delay time, drag the Time Delay icon from the lower right to the macro display on the left.

Release the mouse button at the location where you would like to add the time delay step.
The **Button Test** step causes the macro to execute the following steps ONLY IF the button that the macro is attached to is Held Down for a specified amount of time or Double-Clicked within a specified amount of time, depending on the option selected.

The **Button Test** steps are conditional statements or “Else” commands meaning that if the condition is met the first command will be sent and if the condition is not met the second command will be sent.

**Held Down** - In the example above, if the button is held down for 0.3 seconds, the **ON** command will execute. If the button is not held down for 0.3 seconds, the command will not execute.

This can be used to make a source button that switches pages if pressed briefly, or switches pages and turns equipment on if held down for the specified amount of time. This can also be used to send a command when pressed briefly, or send a different command when held down.

**Double-Clicked** – In the example above, if the button is double-clicked within 0.3 seconds, the **ON** command will execute. If the button is not double-clicked within 0.3 seconds, the command will not execute.

This can be used to make a source button that switches pages if pressed once, or switches pages and turns equipment on if double-clicked within the specified amount of time. This can also be used to send a command when pressed once or send a different command when double-clicked.
**Button Pause** - The Button Pause step causes the macro to stop executing until the button it is attached to is released. This essentially executes a command(s) when the button is pressed and another command(s) when the button is released.

In the example above, if you press and hold the button that the macro is attached to, the macro will execute the first command and wait until the button is released, then execute the rest of the commands in the macro. This works well for commands like Scan on some VCR’s and DVD players, which you need to send the Play command to stop the Scan function.

**Page Link** - The Page Link step causes the macro to change the currently displayed page to the page (and frame) you have selected from the drop-down list. If you have put a Page Link directly on a button as well as in a macro on the same button, the Page Link that is directly on the button will be the last visible change (after the macro is done running).

Shown in the example above is one way you could make one button go to two different pages using the Page Link step with the Button Test step in a macro.

The Page Link step also allows you to select a specific frame within a page. This is useful if you want to display a very specific group of buttons or if you want to create an animation by jumping through many frames that contain graphics.
Stop Macro - The Stop Macro step causes the macro to stop executing at the point where it is inserted.

Macros automatically stop when they reach the end so you should not normally need to insert a Stop Macro step. It is intended for use in conjunction with the Button Test step, or some other “if-then-else” statement, where you can have the macro stop if a condition is met.

Repeat Steps - This step causes the macro to execute a command(s) a specific number of times. The maximum number of repeats that can be entered is 60. Additionally, this step can be configured to execute a command(s) over and over until the button is released.

Shown in the example above the Volume command will execute 10 times. This is useful for presetting the volume to a specific level when the system is turned on.

Status Test - This step allows you to execute a command(s) based on the input to the PWR or AUX Status pins on the keypad’s rear connector. If a valid voltage is present on the PWR Status pin then the Power Status is considered On, otherwise it is considered Off. The same is true for the AUX Status pin. Additionally, you can execute a command(s) based on the state of the Relay Control output pin. If a voltage is present on the Relay Control pin, then the relay is considered closed (On), otherwise it is considered open (Off).

Shown in the example above the Power Off command will execute only if a valid input voltage is applied to the PWR Status pin on the back of the keypad.
**LED Control** - This step allows you to manually change the color of the LED behind the keypad’s OFF hard button. This step will be ignored if you do not enable software control of the power LED in the Device Properties setup.

**Beep** - This step causes the keypad’s internal beeper to sound off.

**Relay Control** - This step allows you to set the state of the relay control output pin. This can be used to control the Sonance mute speaker relay (Sonance part number 91550). The output pin can be set to On (closed), Off (open), or Toggle (the opposite of its current state).

**Toggle IR Code** - The Toggle IR Code step causes the macro to alternate between two different IR codes every other time the button is pressed.

In the example above, each time the button that the macro is attached to is pressed, the commands alternate. The initial button press executes the A command and the second button press executes the B command.

If you have equipment that uses toggle codes, you must learn each code twice, and then place the two codes within the Toggle IR Code step. Every time the macro is run, it will send out only one of the two codes inside of the Toggle IR Code step, switching back and forth each time the button is pressed.

The **Toggle IR Code** command is an advanced feature. If you have trouble with this feature, contact Technical Support for help.
HOW TO DELETE A MACRO

To delete a macro from a button:

1. Select the Delete tool \(\times\) from the Tool Palette.
2. Place the mouse cursor over the button with the macro you wish to delete.
3. Click the left mouse button.
4. Select Delete Macro from the menu.

HOW TO EDIT AN IR COMMAND IN A MACRO

1. To edit an individual command in a macro you must have the macro displayed in the Macro Editor.
2. Double click on the command in the macro you want to edit to open the Edit Infrared Command dialog box.

The Edit Infrared Command options are:

- **Minimum Repeats** - Enter in this box the number of times that the repeating part of the IR code is sent by the remote. Some infrared receivers need a command to be repeated a certain number of times to work properly, and some may not work properly if the command is repeated at all. Even if a command works properly, increasing the number of repeat times may be necessary if the command is to be used in a macro. Since macro commands are not automatically sustained while a button is pressed, they may need to automatically repeat more times to be recognized.

- **Frequency** - Shown in this box is the carrier frequency of the IR code, this is set automatically. You should not need to change this value unless directed to do so by Technical Support.

- **Repeat while button is pressed** - Check this box to cause this IR code to be repeated for as long as the button is held down.

  **Note:** Only one command in any macro can have this property set.
HOW TO USE THE CHANNEL MACRO WIZARD

*Navigator K2 Manager* comes with a feature called the Channel Macro Wizard. The Channel Macro Wizard allows you to quickly and easily create macros for satellite and cable channel presets.

To start using the Channel Macro Wizard:

1. Select **Channel Macro Wizard** from the **Edit** menu.

2. Click the **Select New Remote** button to select the remote that you will use to enter the channel numbers and click the **Next >>** button.

3. You have the option of adding commands before and/or after each macro for things such as an IR router before each command or an Enter command after.
4. Click the **Add/Edit** in the BEFORE or AFTER section if choose to add commands. This will open the **Macro Editor** where you can select the commands using the **Macro Editor** commands. If you need help with these commands, see the “**How to Use the Macro Editor**” section.

![Channel Macro Wizard](image)

5. Click the **Next >>** command button.

6. Select the page you wish to place macros on from the **Page** drop-down list and then select the frame by clicking on the Left and Right frame arrows.
7. Select the number of digits in the channel macro from the Spin box in the lower right corner. If you enter more digits than selected the numbers will wrap around.

8. Click the first button from the touchscreen grid on which you want to place a macro.

9. Enter the channel numbers by either clicking the numbers in the Channel Macro Wizard with the mouse or you can enter them with the numbers on the keyboard.

10. Click Save after you enter each macro.

11. Click Close when finished with all your channel macros.

HOW TO CREATE A NEW SCROLLING LIST

The scrolling list feature allows you to create a vertical scrolling list of up to 500 entries (CD titles, MP3 songs, or other data). Each entry has an embedded macro that executes a series of commands in response to the user selecting the entry on the keypad’s touchscreen.
To create a scrolling list:

1. Select **New Scrolling List** from the **Page** menu.
2. Enter the **Scrolling List Properties**.

The **Scrolling List Properties** are:

**Title** – Enter in this box a name for the scrolling list.

**First Disc Number** – Select the starting disc or song number for the particular jukebox that you are using. This is usually 1 or 0, but doesn’t have to be. The purpose of this number is to allow the **Disc Number Macro Wizard** to build the correct infrared codes to control the jukebox.

**Total Number of Discs** – select the total number of discs that are going to be in your list.

**Disc Number Macro Wizard** – Click on this button to run a wizard that will automatically build the macros for each entry in the list. After executing the wizard, you can still make manual changes to any of the macros.

**Warning** - Running this wizard will overwrite any existing macros in the list.

**Sort Order** – Select the criteria for sorting the list entries when they are displayed on the keypad’s touchpanel.

**Use +/- keys to scroll** – Check this box if you want the keypad’s + and – hard buttons to perform the same scrolling function as the Up and Down arrow buttons at the bottom of the touchscreen. If this option is selected, any IR codes or macros assigned to the + and – hard buttons will be ignored on that page.

3. Select **OK** after entering the Scrolling List Properties.
4. Enter the Artist and Title information into the **Scrolling List Editor**. This is done by clicking the mouse in the appropriate cell and typing in the desired information. If you type in more text than can fit on the keypad’s touchpanel, the characters that get cut off are colored red.

5. Create or edit the macros if necessary. You can click on the macro cell for any entry to create or edit its macro programming. You can see an entry already has a macro assigned to it if the button in its macro cell is “pushed down”.

6. Click **Close** when done.

Scrolling list Artist and Title information can also be imported into the Scrolling List Editor from Microsoft Excel. Columns “A” and “B” become the Artist and Title column respectively. See Appendix A for a more detailed description of this as well as using this technique for importing information from the Sonance Concierge.

**HOW TO EDIT A SCROLLING LIST**

To edit an existing scrolling list:

1. Make the scrolling list the active page by selecting it in the Page List.
2. Click the mouse cursor anywhere in the touchscreen grid.
3. Use the **Scrolling List Editor** as above to make any desired changes.
4. Click **Close** when done.
HOW TO EDIT THE DEVICE PROPERTIES

The **Device Properties** dialog box allows you to change settings that affect the entire keypad. This is the same information that can be set directly on the keypad through the Control Panel. **Note that the keypad Control Panel settings are overwritten in favor of the Device Property settings each time a new file is loaded in to the keypad.**

To open the **Device Properties** dialog box:

Choose Edit Device Properties from the Edit menu.

POWER TAB

The **Power** tab options are:

**Power Down Time:** This allows you to adjust the time the unit stays powered up after the last button press. The time is variable from 1 second to 60 seconds (default is 10 seconds). During power down mode, the *Navigator K2* changes to the power down backlight level.

**Normal Backlight Level:** This is the backlight brightness level that is used when the *Navigator K2* is in the power up mode (when it is awake). The options are High, Medium, Low, and Off. Regardless of the backlight level, the display remains on during this state.

**Power Down Backlight Level:** This is the backlight brightness level that is used when the *Navigator K2* is in the power down mode (when it is asleep). The
options are Medium, Low, Off, and Display Off. If the Display Off backlight level is selected both the backlight and the display will be off during this state.

**MISC. TAB**

![Device Properties](image)

The **Misc.** tab options are:

**Enable Beeper:** Check this box to enable the beeper. If this box is checked, the *Navigator K2* will beep every time a button is pressed.

**Scroll Rate:** Slide this control to set how fast the frames scroll left and right when the frame scroll arrows are pressed.

**Frame Scroll Wrap:** Check this box to enable page frames (or scrolling lists) to wrap around to the beginning after the last frame (or entry) has been reached. The wrap around feature works in both directions.

**Enable IR Receiver:** Check this box to enable the infrared pass-through receiver located on the front of the *Navigator K2*. If this box is checked it will allow unaltered infrared codes to be passed from a handheld remote control to the IR DATA output port on the back of the *Navigator K2*. 
SECURITY TAB

This tab allows you to set the passcode that is needed for the **Clear All** function on the control panel page and the **Secured** function that is available on all buttons. The default passcode is **0000**.

KEY LABELS
This tab is used to assign names or labels to the *Navigator K2’s* six “hard” Source Buttons. For each of the six buttons, you should use the pull-down list to select the label that you want to appear in the Design Window of the software. The list of available labels matches the buttons included in the *Sonance Navigator K2 Button Accessory Kit* (Sonance part number: 91949).

**GLOBAL KEYS**

![Device Properties](image)

This tab is used to assign global status to any of the *Navigator K2’s* “hard” buttons. If a button is selected to be global it will do exactly the same thing on every page. In other words, a global button will perform the same command, macro, page link, etc. on all pages. If a button is not selected to be global it will perform independently on every page. All of the *Navigator K2’s* hard buttons are global by default, except the **Up** and **Down** buttons.
This tab is used to configure the K2’s keypad synchronization feature. This feature allows up to 10 keypads to be wired together so they track changes that occur on any keypad in the group. To implement this feature all keypads in the sync group must have their GND and KEYPAD SYNC pins tied together, and each keypad should have the **Enable Keypad Syncing** box checked.

An idle keypad in the sync group will track event changes made to an active keypad in the group only if the **Event** is enabled on the idle keypad and the **Channel** number matches that of the active keypad. For each event the channel number can be set from 1 to 8. The channel number normally doesn’t need to be changed from the default setting of 1, but it can be for unique situations.

**Example:** Four keypads (Keypad 1, Keypad 2, Keypad 3, and Keypad 4) are wired together and you want them to behave as follows:

- All of them should track each other’s Page Changes, Frame Changes, and Scrolling List Position Changes.
- Keypad 1 and Keypad 2 should only track each other’s Relay Status Changes.
- Keypad 3 and Keypad 4 should only track each other’s Relay Status Changes.
- None of them should track Manual Power LED Changes.

Each keypad’s Sync settings should be configured as follows:
Keypad 1:

![Device Properties Window 1]

Keypad 2:

![Device Properties Window 2]
Keypad 3:

Keypad 4:
POWER LED

This tab is used to select what determines the color of the LED behind the Navigator K2’s OFF hard button. This LED can be set to track the PWR Status input pin and/or the Relay output pin. Additionally, the LED can be set to only change color under software control using the Macro Editor (see “LED Control” in the “How to Use the Macro Editor” section).
HOW TO EDIT BUTTON PROPERTIES

The **Edit Button Properties** dialog allows you to edit many different attributes of a button or a group of buttons.

To open the **Edit Button Properties** dialog box:

1. Select the **Edit Button Properties** tool from the **Tool Palette**.
2. Click the button you want to edit, either touchscreen or hard buttons.

**Note:** Not all of the tabs and/or controls will be available simultaneously. Only the options relevant to the button being edited will be shown.

GENERAL TAB

The options on the **General** tab are:

**Disabled** - Check this box to prevent the button from responding (beeping or reversing/pushing in) when it is touched.

**Note:** Disabled buttons can still have commands, macros, and page links. The disabled property refers only to the appearance of the button, not the functionality.
Reversed - Check this box to cause the button to be displayed in a reversed or pushed-in state when the button is not pushed and the normal state when the button is pushed. The reversed state is “filled-in” for Rectangular, Radius, Oblong, and Borderless buttons, and “Down” for Custom Buttons.

Note: This property does not apply to 3D buttons.

Secured - Check this box to require that the security code be entered before the action (command, macro, or page link) associated with this button is run. The security code is set using the Edit Device Properties command on the software’s Edit menu.

Pause - Enter in this box the number of seconds for the Navigator K2 to halt performing any actions after the button is released. This value will not usually need to be changed from 0.

INFRARED TAB

The Infrared tab options are:

Min. Repeats - Enter in this box the number of times that the repeating part of the IR code is sent by the remote. Some infrared receivers need a command to be repeated a certain number of times to work properly and some may not work properly if the command is repeated at all. Change this setting only if you are having trouble with a command.
**Frequency** - This box shows the carrier frequency of the IR code. This is set automatically. You should not need to change this value unless directed to do so by Technical Support.

**Sustain** - Check this box to control whether or not the IR code should repeat if the button is held down. Most infrared codes will transmit continuously as long as the button is held down, but some infrared receivers may not work properly if the command is repeated at all. If the Sustain button is checked, the code will be transmitted for as long as the button is held down or the Minimum Repeat times, whichever is greater. If the Sustain button is not checked, the code will be transmitted only the Minimum Repeat number of times regardless of how long the button is held down.

**Command Information** - This information tells you what remote control or device the IR code came from.

**WAVEFORM TAB**

The **Waveform** tab displays the waveform of a command for advanced troubleshooting or if you would just like to see what Infrared data looks like.
HOW TO EDIT THE PROPERTIES OF MULTIPLE BUTTONS

The Edit Button Properties dialog allows you to edit many different attributes of a button or a group of buttons.

To edit the properties of multiple buttons at once:

1. Select the buttons using the Select Button tool from the Tool Palette.
2. Click the right mouse button on one of the selected buttons, either touchscreen or keypad buttons and choose Edit Properties.

For an explanation of all the button properties, see the “How to Edit Button Properties” section.

Note: Not all of the tabs and/or controls will be available simultaneously. Only the options relevant to the button(s) being edited will be shown.

A note about Multiple Selections

If you have more than one button selected, it is possible that they will initially have different settings.

The following meanings apply to options with a check box:

☑ All buttons in the selection will retain their original values for the setting.
☑ All buttons in the selection will have the setting set to TRUE
☐ All buttons in the selection will have the setting set to FALSE

If options with numerical fields have different values, they will be left blank. If you DO NOT enter a number, all the buttons will retain their original setting. If you DO enter a number, all the buttons will be set to that value.

If options with radio buttons have different settings, NONE of the radio buttons will have a dot next to them. In that case, each button will retain its original function. If you do wish to assign the SAME function to EVERY button, select one of the functions from the dialog.
HOW TO USE THE “IR CODE SEARCH & REPLACE” FEATURE

This feature allows you to easily replace all occurrences of a certain IR code in your file with a different IR code. This is a great time saving feature to use if, for instance, you replace one of your components (Surround Sound Receiver, DVD Player, etc.) with a different make or model.

1. Choose **IR Code Search & Replace** from the **Edit** menu.
2. A list of all IR codes that exist in your **Navigator K2** file will appear.
3. Use the **Infrared Library Browser** to drag and drop the desired IR code(s) on top of the code(s) in the list to be replaced. When you replace a code in the list with a new one from the library, the original code will be replaced in every button and macro that it is programmed onto.
4. Close the IR Search and Replace window by clicking the mouse cursor over the close button in the upper right-hand corner of the window.

HOW TO PRINT SYSTEM CONFIGURATION REPORTS

**Navigator K2 Manager** comes with the ability to create System Configuration Reports. This report is for archival purposes as well as a visual reference guide of the device options and configuration.

To print the Configuration Report of the open remote file:
1. Choose **System Configuration Report** from the **File** menu.
2. Click the **Print** command button.
3. Click **OK**.

To copy the Configuration Report of the open remote file to the Windows clipboard:
1. Choose **System Configuration Report** from the **File** menu.
2. Click the **Copy** command button.
3. The **System Configuration Report** is now on the Windows clipboard.
4. Click **OK**.

**HOW TO CHECK MEMORY USAGE**

It is possible, though not likely, to create a file in **Navigator K2 Manager** with more information than the **Navigator K2** can hold. To make sure this does not happen, use the **Check Memory Usage** command on the **Edit** menu to see how large the current file is.

The **Device Memory Used** dialog displays the amount of space that buttons, bitmaps, custom buttons, commands, and macros take up in the **Navigator K2** keypad’s 192KB of memory. The pie chart in the dialog represents the amount of memory that each of the object types uses.

If the memory is more than 100% full, the **Free** line will show a negative number and will be flashing red. In this case, the following warning will be displayed:

![Warning](image)

This file is too large to send to the Navigator K2.

You will have to delete enough objects so that the **Free** line is not flashing red before you can send this file to the **Navigator K2**.

**HOW TO CREATE A “SELF-DOWNLOADING .EXE”**

This command creates an executable from the current file that will automatically download itself to the remote when run. These executables can be distributed to client sites to simplify the process of updating keypads in the field.
Navigator K2 keypad

*Navigator K2 Manager* does not need to be installed for the self-contained executable to work.

To make a Self-Downloading .EXE of the current file:

1. Choose *Create Self-Downloading .EXE* from the *Communications* menu.
2. Choose the location you want to save the file in the *Save in* address box.
3. Enter the name of the file in the *File Name* box.
4. Click the *Save* button to save and close.

You can now put the .EXE file on a diskette or E-Mail it.

**HOW TO USE THE “SEND” COMMAND**

This command sends the current file through electronic mail. This command is only available if your computer has a properly configured e-mail client that is compatible with the Microsoft ® MAPI specification. Microsoft Exchange and Microsoft Outlook are two examples of MAPI-compliant e-mail clients.

To send the current file via E-Mail:

1. Choose *Send* from the *File* menu.
2. The default E-Mail program will open with the current file inserted as an attachment with the extension .sna.
3. Send the E-Mail as required by your E-Mail program.

**HOW TO UPDATE THE FIRMWARE**

This command sends a firmware file to the keypad using the programming port. This will replace the keypad’s internal operating system and application code.

To update the firmware:

1. Connect the Programming Cable from the *Navigator K2* serial port to the desired COM port on your computer. This should be the COM port you set up using the *Communications Setup* dialog.
2. Choose *Update Firmware* from the *Communications* menu.
3. Click *OK.*
4. Select the desired firmware update file (.rfw extension) and click **Open**.
Chapter 6. Image Editors

The Navigator K2 Manager software comes with two additional programs for creating custom graphics. These programs are very similar in appearance and functionality and both programs can be accessed from the Library menu within the Navigator K2 Manager program.

The Button Bitmap Editor is for creating and editing button bitmaps for such things as channel and transport icons.

The Custom Button Editor is for creating and editing custom buttons for such things as company logos or complex groups of controls.

THE DIFFERENCE BETWEEN CUSTOM BUTTONS AND BITMAPS

Custom Buttons have several fundamental differences from Bitmaps:

1. Custom Buttons must specify an image of the entire button. Bitmaps are smaller and therefore can be placed on buttons with the standard border styles.

2. Custom Buttons can contain more than one active button area, so a whole group of related controls can be created as a single Custom Button. Bitmaps are indivisible, and must be placed separately onto individual buttons.

3. Custom Buttons must provide an image for both the Up (normal) and Down (pressed) states of the button. Bitmaps provide only the Up image. The Down image of a Bitmap is created by simply inverting it.

4. Custom Buttons can be any size, up to the entire display size. Bitmaps are limited to a handful of pre-defined sizes.

Given these characteristics, Custom Buttons are most appropriate for complex or large groups of controls, such as a customized set of transport controls for a VCR or a large company logo.

Bitmaps are most appropriate for small pictures that don’t need a full button to display, such as TV channel icons or small logos. Since Bitmaps don’t have a Down image, they take half as much memory to store in the Navigator K2, so more Bitmaps can be created.

Both Custom Buttons and Bitmaps are stored within Libraries not as individual files. Before you can design your own Custom Buttons or Bitmaps you must create a new library file using the Custom Button Editor or Button Bitmap Editor. The library file can have many Custom Buttons or Bitmaps within it. The Custom Button and Bitmap files included with the Navigator K2 Manager software are
tagged as read-only so that images you design will not be overwritten with new versions of the software.

**BUTTON BITMAP EDITOR SCREEN**

To open the **Button Bitmap Editor**, select **Button Bitmap Editor** from the **Library** menu in the **Navigator K2 Manager** program.
To open the Custom Button Editor, select Custom Button Editor from the Library menu in the Navigator K2 Manager program.
TOOLBAR

The toolbar provides instant access to commonly used *Button Bitmap Editor* and *Custom Button Editor* functions.

![Toolbar Icons]

**Create New Library Command** – Use this command to create a library to hold your custom buttons or bitmaps. The built-in libraries that come with the software are read-only and new images cannot be saved to them. This command should only be used when a new library is desired. If you want to create a new image, use the **Create New Image Command**.

**Open Library Command** – Use this command to open existing libraries. The currently open library, if any, will be closed.

**Edit Library Command** – Use this command to rename or delete a custom button or bitmap in a library that you created. The built-in libraries that come with the software are read-only and images cannot be edited. This command is not available unless a Bitmap Library is open.

**Create New Image Command** – Use this command to create a new image in the currently open library in the *Bitmap Editor* (the *New Bitmap Size* dialog will be displayed) where you can select the size for the new Bitmap. The built-in libraries that come with the software are read-only and new images cannot be saved to them.

**Open Image Command** – Use this command to open an existing image in the currently open library for editing. When you choose the **Open Image** command, the **Open Image** dialog box is displayed to allow you to select which image to edit. This command is not available unless a Bitmap Library is open.

**Save Image Command** – Use this command to save the current image to the currently open library. If the image has already been saved, this command updates the existing version. If the image has never been saved before, this command is the same as the Image **Save Image As** command, and displays the **Edit Title** dialog for you to enter a name. This command is not available unless a library is open and an image is being edited.
**Navigator K2 keypad**

**Undo Command** – Use this command to reverse the last change you made to the image. Choose the **Undo** command again to reverse the previous change. A maximum of 64 changes are reversible with the **Undo** command. The **Undo** command can only reverse editing changes to the current image. It cannot undo changes to a library. The **Undo** information is destroyed when the image is closed or the view is toggled between the Up and Down images in the **Custom Button Editor**.

**Redo Command** – Use this command to cancel the effect of the last **Undo** command. Choose the **Redo** command again to cancel the next Undo. A maximum of 64 changes can be canceled with the **Redo** command. The **Redo** command can only cancel Undo commands to the current image. The Redo information is destroyed when the image is closed, when the view is toggled between the Up and Down images, or when other editing changes are made to the image.

**Cut Command** – Use this command to move the selected sections to the Clipboard. This replaces the selection with solid white. You can use this to move images between the Button Bitmap Editor and the Custom Button Editor.

**Copy Command** – Use this command to copy selected sections to the Clipboard. This command does not alter the current image. You can use this to move images between the Button Bitmap Editor and the Custom Button Editor.

**Paste Command** – Use this command to place previously cut or copied sections from the clipboard back onto the touchscreen grid and switches the Button Bitmap Editor or Custom Button Editor into **Selection** mode. You can drag the pasted sections to the desired position on the page. You can use this to move images between the Button Bitmap Editor and the Custom Button Editor. This command is not available if the data on the Clipboard is not in bitmap format.

**Help Topics** – Use this command to open the **Help Topics** dialog box for more help.
TOOL PALETTE

The Tool Palette provides access to all the drawing tools used by the Button Bitmap Editor and Custom Button Editor.

**Selection Tool** - The Selection Tool is used to define a rectangular selection region on the image. To define a selection, click the left mouse button in the Drawing Area where one corner of the selection rectangle should be placed, drag the mouse to the opposite corner, and release the mouse button.

**Button Selection Tool** (Custom Button Editor only) - The Button Selection Tool defines the active button areas on a Custom Button image. To define a button selection, click the left mouse button in the Drawing Area where one corner of the selection rectangle should be placed, drag the mouse to the opposite corner, and release the mouse button. To remove an existing button selection, place the mouse cursor inside of the selection you wish to remove and click the right mouse button.

**Zoom Tool** - The Zoom Tool is used to magnify portions of the image. Click the left mouse button over a spot in the Drawing Area to “Zoom In” (make the image larger) or click the right mouse button over a point to “Zoom Out” (make the image smaller). The Zoom commands on the View menu can also be used to change the Zoom level.

**Pencil Tool** - The Pencil Tool is used to color individual pixels on the image. Click the left mouse button in the Drawing Area to turn the pixel under the Pencil point black and click the right mouse button to turn the pixel white.

**Brush Tool** - The Brush Tool acts like the Pencil Tool but colors a larger portion of the image. The Brush Size, the size of the shape that the Brush draws, can be changed by clicking on a different sized brush in the rectangular area below the drawing tools or by choosing a size from the Brush Size menu under the View menu. Click the left mouse button in the Drawing Area to turn the pixels under the Brush black and click the right mouse button to turn the pixels white.
Fill Tool - The **Fill** Tool is used to color large portions of the image. Several Fill Patterns are available in the rectangular area below the drawing tools. To use the Fill Tool, choose the desired Fill Pattern and then click the left mouse button inside of the area to fill. The Fill Tool will color the image with the Fill Pattern in all directions until it encounters a black line or the edge of the image. If the fill is to be contained to the inside of a shape, be sure that there are no gaps in the shape’s border.

Eraser Tool - The **Eraser** Tool is identical to the Brush Tool except that clicking the left mouse button draws in white and clicking the right mouse button draws in black.

Line Tool - The **Line** Tool is used to draw straight lines on the image. To draw a black line, click and hold the left mouse button in the Drawing Area where one end of the line should go, move the mouse to the other end of the line, and release the mouse button. To draw a white line, follow the same steps but click the right mouse button instead of the left.

Text Tool - The **Text** Tool is used to place text on the image. To place text, click the left mouse button in the Drawing Area and the **Place Text** dialog will appear. Enter the desired text in the dialog and click OK. The text will appear in a blue selection rectangle where it can be placed precisely on the image.

Rectangle Tool - The **Rectangle** Tool is used to draw rectangles on the image. Click the left mouse button in the Drawing Area where one corner of the rectangle should be placed, drag the mouse to the opposite corner, and release the mouse button. To draw a white rectangle, follow the same steps but click the right mouse button instead of the left. The portions of the image in the center of the rectangle are not affected by this tool.

Rounded Rectangle Tool - The **Rounded Rectangle** Tool is used to draw rectangles with rounded corners on the image. The radius of the corners is the same as that of “Radius” buttons on the **Navigator K2**. Click the left mouse button in the Drawing Area where one corner of the rounded rectangle should be placed, drag the mouse to the opposite corner, and release the mouse button. To draw a white rounded rectangle, follow the same steps but click the right mouse button instead of the left. The portions of the image in the center of the rounded rectangle are not affected by this tool.

Circle Tool - The **Circle** Tool is used to draw circles and ovals on the image. Click the left mouse button in the Drawing Area where one corner of the imaginary rectangle that bounds the circle should be placed, drag the mouse to the opposite corner, and release the mouse button. To draw a white circle, follow the same steps but click the right mouse button instead of the left. The portions of the image in the center of the circle are not affected by this tool.
Filled Rectangle Tool - The Filled Rectangle Tool is used to draw rectangles filled with a Fill Pattern on the image. Several Fill Patterns are available in the rectangular area below the drawing tools. To use the Filled Rectangle Tool, choose the desired Fill Pattern, click the left mouse button in the Drawing Area where one corner of the rectangle should be placed, drag the mouse to the opposite corner, and release the mouse button. To draw a solid white rectangle, follow the same steps but click the right mouse button instead of the left.

Filled Rounded Rectangle Tool - The Filled Rounded Rectangle Tool is used to draw rectangles with rounded corners filled with a Fill Pattern on the image. Several Fill Patterns are available in the rectangular area below the drawing tools. To use the Filled Rounded Rectangle Tool, choose the desired Fill Pattern, click the left mouse button in the Drawing Area where one corner of the rectangle should be placed, drag the mouse to the opposite corner, and release the mouse button. To draw a solid white rounded rectangle, follow the same steps but click the right mouse button instead of the left.

Filled Circle Tool - The Filled Circle Tool is used to draw circles and ovals filled with a Fill Pattern on the image. Several Fill Patterns are available in the rectangular area below the drawing tools. To use the Filled Circle Tool, choose the desired Fill Pattern, click the left mouse button in the Drawing Area where one corner of the imaginary rectangle bounding the circle should be placed, drag the mouse to the opposite corner, and release the mouse button. To draw a solid white circle, follow the same steps but click the right mouse button instead of the left.

UP IMAGE-DOWN IMAGE TOOL (Custom Button Editor Only):

Click on the Up Image button to display the Up Image in the Drawing Area, or click on the Down Image button to display the Down Image.

All Custom Buttons have two totally separate images, an Up image, which represents the button in its normal state; and a Down image, which represents the button in its pressed state. The Up image is the picture that is normally displayed by the Navigator K2, unless the button has its Reversed property set, in which case the Down image is normally displayed.
In most cases, you will find it easiest to create the Up image first. As a starting point for creating the Down image, you may want to select the whole Up image, copy it to the Clipboard, switch to the Down image, and paste the image from the Clipboard.

At this point, you can use the editor to modify the image you pasted to make it the Down image. If a simple reversal is all you need, the Invert Selection command on the Edit menu will do the trick.

**NEW BITMAP SIZE DIALOG BOX** (Button Bitmap Editor Only):

The New Bitmap Size dialog box opens when you select the Create New Image command. You can choose from the five sizes listed in the dialog box, a sample of the size will be displayed in the Sample section.

26 by 10 pixels = 1 section wide by 1 section high, which is the smallest button bitmap size.

26 by 26 pixels = 1 section wide by 2 sections high, which is the standard channel icon size.

58 by 26 pixels = 2 sections wide by 2 sections high, which is one-third of the touchscreen

58 by 42 pixels = 2 sections wide by 3 sections high, which is half of the touchscreen.

58 by 58 pixels = 2 sections wide by 4 sections high, which is two-thirds of the touchscreen.
Chapter 7. IR Library Manager

The Navigator K2 Manager software also comes with an additional program for editing and creating IR remote files. The IR Library Manager can be accessed from the Library menu within the Navigator K2 Manager program.

MASTER AND USER COMMAND LIBRARIES

When the software is originally installed, two command library files will be created. The Master.cml consists of ALL of the IR command information that was available at the time the installer was compiled. This file will be overwritten each time that the software is updated. For this reason, you cannot edit the Master command library.

The second file, User.cml, will not be overwritten with future updates. This is where you would create new remotes that do not appear in the Master file.

IR LIBRARY MANAGER SCREEN

![IR Library Manager Screen](image)
TOOLBAR

The toolbar provides instant access to commonly used *IR Library Manager* functions.

**Open Library Command** – Use this command to open existing libraries. The currently open library, if any, will be closed.

**Print Command** – Use this command to print a list of the Manufacturer, Type, and Model of all of the remotes that are part of the current library.

**New Remote Command** – Use this command to create a new remote listing on the current library file. This creates a blank remote. See the Edit tab description later in this chapter for how to create individual commands and assign IR codes to them.

**Duplicate Remote Command** – This command creates an exact copy of the currently selected remote. The manufacturer and type will be preserved and you will be prompted for a new model name. All of the individual commands within the remote will be copied along with the corresponding IR codes.

**Rename Remote Command** – This command allows you to rename the manufacturer, type, or model name of the selected remote.

**Delete Remote Command** – This command will remove the currently selected remote from the library. You will be asked to confirm this deletion before the action is completed.

**Import Command** – This command allows you to import remote file information from other Library Command files. When selected, a browsing window will open allowing you to select the file that you would like to import information from. Once the file is selected, the remote information is imported. Any duplicates will prompt the user to elect to keep the existing information or overwrite with new information. When completed, a report of all of the import remotes is displayed.
**Export Command** – This command allows you to create a subset of the current library file. First you will be asked to select the remotes that you would like to export. Then you will be prompted for the name of the new library.

**Import from Internet Command** – This command opens a connection to the Remote Technologies Inc. internet command library. This is an online database of remote files that have been created and made publicly available for the K2 and other Sonance remotes. Simply navigate through the manufacturer, type, and model number you are looking for and import the file.

**Export to Internet Command** – This command allows you to upload remote files to the RTI internet command library to share with other users. When you select this command, you will be asked to select the remotes from the current library that you would like to upload, some general information about the model number, and any other comments that would be helpful.

**Help Topics** – Use this command to open the Help Topics dialog box for more help.

**REMOTE FUNCTION WINDOW**

This portion of the IR Library Manager provides a line by line view of each function of the selected remote file.
### Function Column
This column has the name of each command that is part of the remote file. The red dot next to the function name indicates that there is an IR code associated with that particular function.

### Frequency Column
This is the carrier frequency that the IR code will be transmitted at. This can be edited directly from this screen by selecting the box with the mouse and typing in a new frequency.

### Repeats Column
Enter in this box the number of times that the repeating part of the IR code is sent by the remote. Some infrared receivers need a command to be repeated a certain number of times to work properly, and some may not work properly if the command is repeated at all. Even if a command works properly, increasing the number of repeat times may be necessary if the command is to be used in a macro. Since macro commands are not automatically sustained while a button is pressed, they may need to automatically repeat more times to be recognized.

### Sustain Column
Check this box to control whether or not the IR code should repeat if the button is held down. Most infrared codes will transmit continuously as long as the button is held down, but some infrared receivers may not work properly if the command is repeated at all. If the Sustain button is checked, the code will be transmitted for as long as the button is held down or the Minimum Repeat times, whichever is greater. If the Sustain button is not checked, the code will be transmitted only the Minimum Repeat number of times regardless of how long the button is held down.

#### Sonance / System Controller / Nav Harbor (party)

<table>
<thead>
<tr>
<th>Function</th>
<th>Frequency</th>
<th>Repeat</th>
<th>Sustain</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Off</td>
<td>38.0 KHz</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Mute</td>
<td>38.0 KHz</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Power Off</td>
<td>38.0 KHz</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Power On</td>
<td>38.0 KHz</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Source 1</td>
<td>38.0 KHz</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Source 2</td>
<td>38.0 KHz</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Source 3</td>
<td>38.0 KHz</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Source 4</td>
<td>38.0 KHz</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Source 5</td>
<td>38.0 KHz</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Source 6</td>
<td>38.0 KHz</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Volume -</td>
<td>38.0 KHz</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Volume +</td>
<td>38.0 KHz</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
CREATING, EDITING AND ASSIGNING IR CODES TO REMOTE FILES

Using the tabs and their associated function located below the remote function window, new commands and complete remotes can be created and edited.

From the **Edit** tab, new functions can be added to the current remote. Type in the name of the function or select it from the pull down list then press the Add button to place it in the list.

A function can be removed from the list by pressing the **Delete Function** button. Or you can simply clear out any IR code information from a function by pressing the **Delete Learned Code** button.
From the **Capture** tab, IR codes can be learned into each function by means of either a T2 remote or a dedicated IR learner device. **Note: The K2 CAN NOT learn in IR codes.** To learn codes in, press the **Enable Capture** button and follow the screen commands. Also consult your selected learner’s manual for more information.

The **Waveform View** tab allows you to check information on the IR code of each function including Encoding type, hex data file, and other info.
The **Hex View** tab allows you to see the hex encoding of each IR code. In addition, from this tab you can type in hex code info. This is useful for copying codes from other remote software applications. If other software applications allow you to view the hex information, you can copy the data then return to the *IR Library Manager* and paste the data in for each function. Press the apply button for the hex data to be applied to the particular function.
Chapter 8. Troubleshooting

If you have difficulty with your Navigator K2 keypad, read through these troubleshooting tips and common questions before contacting technical support.

If you continue to have difficulties, do not hesitate to contact technical support. See chapter 9 for more information on contacting Sonance.

COMMUNICATION PROBLEMS

Make sure you are using the programming cable that was supplied with the unit and that both ends are connected securely.

If the only serial port on your computer has a serial mouse plugged into it, you can disconnect the mouse and use that port with the Navigator K2 Manager software. If you do this, you MUST restart Windows with the mouse unplugged before Navigator K2 Manager will be able to use the port.

If the serial port you are trying to use is COM 3 or COM 4, make sure that it is not sharing an interrupt request (IRQ) line with COM 1 or COM 2. The default configuration for COM 1 and COM 3 both share IRQ 4, and COM 2 and COM 4 both share IRQ 3. Contact your computer manufacturer for more information on configuring your serial ports.

If you are trying to use the second serial port on your computer, it is possible that it is disabled in the computer’s CMOS (or BIOS) setup. Consult your computer’s documentation or contact your computer manufacturer for more details.

If your computer is a notebook or laptop, be sure that the external serial port is enabled properly. Some laptops, especially (but certainly not limited to) IBM ThinkPads, have their external ports disabled by default.

- If your computer has an IrDA infrared port, there may be a setting where you can choose between the infrared port and the serial port.
- Some portable computers with Advanced Power Management disable the external serial ports to conserve battery power.
- Some with PCMCIA card sockets reserve the COM 2 connector for use with a PCMCIA card.
• You may need to run your computer’s setup or configuration program to enable the port. Consult your computer’s documentation or contact your computer manufacturer for more details.

Make sure no other software running on your computer is trying to access the serial port. If you have a PDA, scanner, graphics tablet, fax modem, or other serial devices that plug into the same serial port, you need to disable its software and restart Windows before Navigator K2 Manager can use that serial port.

If you have an internal modem and an external COM port at the same address, the external COM port will not work and must be reconfigured. For example, if the internal modem is set to use COM 2, the computer’s built in COM 2 port will not function correctly.

Use the Auto Detect option in the Communication Setup dialog box. Use the Set COM Port command on the Options menu to display the Communication Setup dialog box and then click the Auto Detect command button to determine which serial port the keypad is connected to. The serial port on your computer may be mislabeled.

If you are communicating with the Navigator K2 and the transfer fails after some data has been transferred, your computer may not support Navigator K2 Manager’s high-speed communication protocol. Use the Set COM Port command on the Options menu to display the Communication Setup dialog box and select the “Medium” or “Low” communication speed.

MACRO PROBLEMS

If you are having problems with missed commands in macros but the IR commands work fine when placed on individual buttons try editing the Minimum Repeats in the Macro Editor to increase the number of times the command is repeated.

Click on the Edit Macro tool from the Tools dialog box on the bottom of the main screen, click on the button on which the macro you are having trouble with is. When the Edit Macro dialog box opens, double-click on the specific IR command you are having the trouble with. When the Edit Infrared Command dialog box opens, change the number of repeats to 4 or 5 to start with and if that doesn’t work, bump it up to 7 or 8.
As always, when you make any changes to your file, be sure to send the new file to the keypad and thoroughly test your changes.

**IR PROBLEMS**

If your IR system is not functioning properly, the first thing to check is the IR receiver. Each K2 has an IR pass-thru receiver to allow hand held remotes to work with the system. This receiver comes disabled from the factory.

If both hand held data and data loaded into the keypad is not functioning, check that the IR receiver is turned OFF. This can be set at the keypad through the control panel (chapter 2) or the edit device properties screen from the software (chapter 5). If the receiver is ON, then any residual visible or electronic noise in the room can interfere with the IR data. Turn the receiver OFF and try your commands from the keypad again.

If the system functions after disabling the IR receiver, try to locate the source of interference. Likely sources are fluorescent, halogen or neon lights, direct or reflected sunlight, electronic noise from tube or flat panel televisions, or infrared security sensors.

If the system still does not function after the IR receiver is turned OFF, check your keypad file to be sure that there is an IR command associated with the button in question. Also check that the IR command has a proper IR code with a carrier, if appropriate. Visual Emitters (Sonance VE1 or VE2) can also be very helpful to see IR activity when troubleshooting the system.
Chapter 9. Service and Support

UPDATES AND NEW PRODUCTS

For news about the latest updates, new product information and accessories, please visit our web site at:

www.sonance.com

CONTACTING SONANCE

For general info, you can contact Sonance at our website:

www.sonance.com

Sonance
Tel. (949) 492-7777 or (800) 582-7777
Fax (949) 361-5151 or (800) 538-5151

SONANCE TECHNICAL SUPPORT

At Sonance, customer service and satisfaction is an utmost priority. If you are encountering any problems or have a question about your Sonance product, please contact Sonance Technical Support for assistance.

Sonance provides technical support by telephone, fax, or E-mail. For the highest quality service, please have the following information ready, or provide it in your fax or E-mail.

♦ Your Name
♦ Company Name
♦ Telephone Number
♦ E-mail Address
♦ Product model and serial number (if applicable)
If you are having a problem with hardware - note the equipment you are using, what the problem is you are having, and any troubleshooting you have tried.

If you are having a problem with software - note what version of software you are using, the operating system on your PC, what the problem is you are having, and any troubleshooting you have tried.

If you are calling in regards to a software or programming question or problem, please be at your computer when you place your call, this will considerably speed up the troubleshooting process.

For technical support or assistance with your Navigator K2 keypad, software, or accessories, contact Sonance at:

(800) 592-0772

tech@sonance.com

www.sonance.com

For questions regarding service or repair of your Navigator K2 keypad, contact Sonance at:

(800) 592-0772

tech@sonance.com

www.sonance.com

Please do not return products to Sonance without return authorization.
SHIPMENT OF NAVIGATOR K2 KEYPAD FOR SERVICE

Sonance will pay all labor and material expenses for all repairs covered by this warranty. If necessary repairs are not covered by warranty, or if a unit is examined which is not in need of repair, you will be charged for the repairs or examination.

If it is necessary to ship the Navigator K2 keypad for service:

Please pack it securely and we suggest that it be insured.

Do not include accessories such as power cords or manuals.

Please back up your internal program. Although every effort is made to save this data and reload it after repair, Sonance is neither liable for its loss, nor responsible for providing a back up for you.

You must pay any shipping charges incurred in getting your Navigator K2 keypad to Sonance. Sonance will pay reasonable return shipping charges via a carrier of our choice to any destination within the United States if the repairs are covered under warranty.

A copy of the original dated sales receipt must be provided whenever warranty service is required. You will need this receipt to establish the date of purchase.
Navigator K2 Keypad
Specifications

Power: +12VDC Regulated Supply (300mA min.)

Power Management: Automatic on/off

Infrared Output Frequency Range: 15kHz – 460kHz

Infrared Pass-through Frequency Range: 20kHz – 120kHz

Operating Temperature: +32°F to +122°F (+0°C to +50°C)

Operating Humidity: 5% to 95% Non-condensing

Touch Panel Display: High-resolution STN LCD Digital Matrix 128 x 64 pixels (Black on White) Touchscreen never needs calibrating

Display size (HW): 2.4” x 1.3” (61mm x 33mm)

Backlights: White LED (Display), Green LED (Buttons)

Total Available Memory: 192K Bytes Flash (non-volatile) memory

Device Capability: Total number of devices is limited only by memory

Macro Capability: Up to 64 steps in a single macro
- Total number of macros is limited only by memory
- Macro capability on every button

Communications: PC compatible RS-232 port

Overall Dimensions: 4.56” x 4.5” x 2.1” (116mm x 114mm x 53mm)

In-Wall Dimensions: 3.65” x 3.58” x 1.87” (93mm x 91mm x 48mm)

Enclosure: Galvanized steel, black anodized

Front Cover Plate: Plastic, polycarbonate
Navigator K2 keypad

Weight: 12.5 oz (356 g)

All specifications subject to change without notice.
Navigator K2 Keypad
Appendix A

IMPORTING MUSIC LIBRARY INFORMATION FROM CONCIERGE SOUND SERVER

1. Using the “Xiva Producer” application (available for free on the Sonance website), select the “Title Export” tool. This opens the Title Export Wizard which will step you through the export process, pressing “Next” when prompted. Please note the setting as defined below.
   • For Data Source, select retrieve data from connected Xiva server.
   • Select .csv for the file format. It is not necessary to select the title limit, the K2 software will handle this.
   • Select all or the desired albums you wish to export.
   • Finally, name the export file and save it to a location that you can get to later.

![Select Albums dialog box]

Select Albums
Select the albums to export

Please select the albums you wish to export:

- [ ] A Pastoral Symphony (Symphony #3) & Symphony #4 - Ralph Vaughan Williams
- [ ] Astro Lounge - Smash Mouth
- [ ] Electric Ladyland - Jimi Hendrix
- [ ] Greatest Hits Vol. 1 - Billy Joel
- [ ] Greatest Hits, Vol. II [1978 - 1985] (Disc 2) - Billy Joel
- [ ] Just Like You - Kab’ Mo’
- [ ] Let Go - Avril Lavigne
- [ ] Only The Lonely - Frank Sinatra

[Next] [Finish] [Cancel]
2. Open the CSV file generated in step 1 in Microsoft Excel. The display will look like the following:

```
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Album (full)</td>
<td>Artist (full)</td>
<td>Album</td>
<td>Artist</td>
<td>Genre</td>
<td>Album No</td>
</tr>
<tr>
<td>2</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
<td>Classical</td>
<td>12</td>
</tr>
<tr>
<td>3</td>
<td>Astro Loun</td>
<td>Smash Mo</td>
<td>Astro Loun</td>
<td>Smash Mo</td>
<td>Alternative</td>
<td>10</td>
</tr>
<tr>
<td>4</td>
<td>Electric La Jimi Hendr</td>
<td>Electric La Jimi Hendr</td>
<td>Rock</td>
<td>10</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Greatest Hi Billy Joel</td>
<td>Greatest Hi Billy Joel</td>
<td>Rock</td>
<td>17</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Greatest Hi Billy Joel</td>
<td>Greatest Hi Billy Joel</td>
<td>Rock</td>
<td>18</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Just Like 'Ykeb' Mo'</td>
<td>Just Like 'Ykeb' Mo'</td>
<td>Blues</td>
<td>1</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Let Go</td>
<td>Avril Lavig</td>
<td>Let Go</td>
<td>Avril Lavig</td>
<td>Pop</td>
<td>11</td>
</tr>
<tr>
<td>9</td>
<td>Only The L</td>
<td>Frank Sina</td>
<td>Only The L Frank Sina Easy Lister</td>
<td>3</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Oops!</td>
<td>I D Britney Spi</td>
<td>Oops!</td>
<td>I D Britney Spi</td>
<td>Pop</td>
<td>9</td>
</tr>
<tr>
<td>11</td>
<td>Shaking TriPeter Cabr</td>
<td>Shaking TriPeter Cabr</td>
<td>Rock</td>
<td>4</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Sister Hazz</td>
<td>Sister Hazz</td>
<td>Sister Hazz</td>
<td>8</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Surfacing</td>
<td>Sarah Mc</td>
<td>Surfacing</td>
<td>Sarah Mc</td>
<td>Alternative</td>
<td>2</td>
</tr>
<tr>
<td>14</td>
<td>Swing</td>
<td>The Manhe Swing</td>
<td>The Manhe Jazz</td>
<td>15</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Symphony Jean Sibell</td>
<td>Symphony Jean Sibell</td>
<td>Classical</td>
<td>14</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>The B-52's The B-52's</td>
<td>The B-52's</td>
<td>The B-52's</td>
<td>6</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
```

Highlight and delete, not just clear, columns C, D, E, and G, leaving column F (Album No). Next highlight and delete row 1. The screen should now look like this:

```
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>2</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>3</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>4</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>5</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>6</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>7</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>8</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>9</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>10</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>11</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>12</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>13</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>14</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>15</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
<tr>
<td>16</td>
<td>A Pastoral</td>
<td>Ralph Vaux</td>
</tr>
</tbody>
</table>
```

Choose “Select All” from “Edit” pull-down menu, then select “Sort…” from the “Data” menu. In the “Sort By” field, choose “Column C” and make sure the “Ascending” sort order is selected. Click OK.

4. In Navigator K2 Manager, choose the “New Scrolling List” command from the Page menu. In the “Scrolling List Properties” screen you can title the scrolling list page. Next make sure that the “First Disc Number” field is set to 0 and the “Total Number of Discs” field is set equal to or larger than the total number of albums imported from the Sound Server. You can change the “Total Number of Discs” at a later time. When finished press “OK”

5. Right-click in the row 0 of the Scrolling List editor’s table and choose “Paste Rows”. The Album titles copied from Excel will be pasted into the Scrolling List editor and the screen will look like this:

![Scrolling List Editor - [Album 1]](image)

6. The red text in the titles indicates titles that are too long to fit on the K2 display. You can click on any cell in the Scrolling List editor to touch up the text, abbreviating as necessary to make the text fit in the available space.

7. Now select “List Properties” button and click the “Disc Number Macro Wizard” button.

8. Click the “Select New Remote” button and open up the MASTER.CML command library. Select the “Sonance/Digital Jukebox/Concierg-00#” code set where “#” is replaced by the Concierge output you will be controlling. If you are setting up a K2 file that will NOT be able to see the GUI of the concierge, select the “Sonance/Digital Jukebox/Concierg-10#” code set where “#” is replaced by the output number. If these codes do not appear in your MASTER.CML file, go to your Library Manager and import them using the Import for Internet command.
9. On Step 2 of the Disc Number Macro Wizard, if you are using the IR commands with the video interface (the Concierg-00# commands) use the “Add/Edit” buttons to build the following macro fragments for Output 1:

10. For Step 2 of the Disc Number Macro Wizard, if you are using the IR commands without the video interface (the Concierg-10# commands) use the “Add/Edit” buttons to build the following macro fragments for Output 1:
11. Click “Next >” twice, and then click OK on the “Scrolling List Properties” dialog. Your scrolling list is now complete. The “Change to Page” command is optional and your Macro may be different. You will need to include some link to direct the K2 away from the list once a selection has been made.

12. Click “Next >” twice, and then click OK on the “Scrolling List Properties” dialog. Your scrolling list is now complete.
Index

—B—

Beeper. See Control Panel
Bitmaps
  Placing, 18
Bitmaps
  difference from Custom Buttons, 59, 69
Button Bitmap Editor
  creating a new bitmap, 67
  screen, 60, 69
Button Bitmaps Editor. See Image Editors,
button properties
  disabled, 52
  editing, 52
  editing multiple, 55
  Infrared frequency, 54
  Infrared minimum repeats, 53
  Infrared sustain, 54
  pause, 53
  reversed, 52
  secured, 53
buttons
  adding, 16
  changing styles, 29
  copying, 30
  cutting, 30
  defined, 16
  deleting, 16
  editing text, 17
  moving, 31
  pasting, 30
  resizing, 31
  selecting, 30

—E—
e-mail
  sending the current file, 56, 58

—F—
features, 3
file
  opening, 22
  previewing, 23
  saving, 22

—I—
Image Editors
  copying, 63
  creating new images, 62
  creating new libraries, 62
  cutting, 63
  drawing, 64
  drawing circles, 65
  drawing filled circles, 66
  drawing filled rectangles, 66
  drawing filled rounded rectangles, 66
  drawing lines, 65
  drawing rectangles, 65
  drawing rounded rectangles, 65

contacting Sonance
  general, 79
  service, 80
  technical support, 79
contents, 2
control panel, 6
  beeper, 7
  change passcode, 8
  clear all, 10
  time out, 7, 8
Custom Button Editor. See Image Editors,
  changing the active image, 66
  defining buttons, 64
  screen, 61
custom buttons
  placing, 31
Custom Buttons
  difference from Bitmaps, 59, 69
editing libraries, 62  
erasing, 65  
filling areas, 65  
getting help, 63  
opening images, 62  
opening libraries, 62, 70  
overview, 59, 69  
painting, 64  
pasting, 63  
placing text, 65  
redoing changes, 63  
saving images, 62  
selecting, 64  
Tool Palette, 64  
toolbar, 62, 70  
undoing changes, 63  
zooming, 64

— M —

macros  
Button Test step, 34  
Channel Macro Wizard, 39  
defined, 32  
deleting, 38  
editing, 32  
editing commands in, 38  
Infrared from Library step, 33  
Infrared from Page step, 33  
Time Delay step, 33  
troubleshooting. See troubleshooting

memory usage  
checking, 57  
defined, 57

— P —

page links. See pages, linking  
pages  
adding, 15  
defined, 15  
deleting, 15  
duplicating, 27

— L —

linking, 21  
merging, 28  
PageWizard, 29  
removing links, 22  
renaming, 27

printing  
system configuration reports, 56

— R —

REMOTE PROPERTIES, 41, 43, 44  
beeper, 45  
passcode, 46  
power down time, 44  
scroll rate, 45

— S —

Self-Downloading .EXE, 57  
specifications, 83  
System Configuration Report. See printing

— T —

technical support. See contacting RTI  
TheaterTouch Designer  
design hints, 13  
installing, 11  
overview, 11  
requirements, 2  
screen, 12  
updates, 11  
time out. See control panel, See control panel  
touchscreen  
overview, 6  
troubleshooting, 75  
macros, 76

— U —

unpacking, 1